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1 Ruskin

Ruskin is the RBR software that manages your RBR loggers to provide all the data necessary to
do your work. Ruskin provides a graphical user interface that makes using the loggers easy. You
can use Ruskin to do the following:

® configure, schedule and enable multiple loggers
® download data after logging

¢ graphically view data sets

® export data in various formats

¢ change the calibration coefficients for your logger

Ruskin can be used on PC and Mac.

eo0e Ruskin v1.13.18 -rad -factory

% Navigator = O |2 066015.20170109_0449.rsk 32 =8
L |Instruments Analysis . Overview | Channels | File info
MMM
v|Ds Datasets I calibration
41 066015_20170.. 9.0449
2 Wi sample q
9l Factory Time

Display statistics
Number of samples

Vale Uit
-0.0006856 | mS/cm
209751550 °C
10.3007203  dbar

263.3026876 umoll
20.8015000  °C

0.1682203  dbar
0.1668485 m
0.0107260  PSU

[7] 066015_20170109_0449.rsk 3
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2 Revision history

Revision No. Release Date Notes

1.0 01-Sep-2012 Original
2.0 01-Oct-2014 Adding RBRsolo D and DO and RBRduet support
B 12-Sept-2017 Final revision for compact loggers
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3 Warranty statement

All data loggers manufactured by RBR Ltd. are warranted against defects in workmanship
or original parts and materials for one year. Third party sensors (not manufactured by RBR) are
limited to the warranty provided by the original manufacturer.

Units suffering from such defects will be repaired or replaced at the discretion of RBR Ltd.,
provided that the problem has appeared during normal use of the instrument for the purpose
intended by us. The liability of RBR Ltd. extends only to the replacement cost of the instrument.
The customer will bear all costs of shipment to us for repair; all other costs, including return
shipment, will be borne by RBR Ltd.

This warranty does not cover consumables or normal wear and tear, nor does it cover damage
caused by negligent use or mishandling. Attempted modification or repair of any unit without the
prior consent of RBR Ltd. will immediately void any warranty in force.

Users are expected to maintain a regular program of calibration.

We reserve the right to grant or refuse warranty repairs at our discretion if we consider that
there are reasonable grounds for doing so.
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4 Introduction

This document introduces you to Ruskin and helps you to use it effectively from the start. It is
specifically written for the RBRsolo and RBRduet loggers - our smallest one and two channel
loggers.

You can access the Ruskin User Guide on the USB data stick provided when you purchase a
logger, from the Help menu in Ruskin, and on the RBR web site, at www.rbr-global.com.

Release notes are automatically displayed each time you install an updated version of Ruskin. The
most recent release notes are also available from the Help menu in Ruskin.

For information about operating and maintaining your data logger, see the Logger Hardware
section. It helps explain how to change the battery and change desiccant, including other useful
information, such as inspecting and replacing O-rings.
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nstallation

Install Ruskin on a PC

You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

[ )
Steps

1.
2.
3.

4.

OS = Windows 7

Processor speed = 1.4GHz

RAM required = 1GB

Display resolution = 1024x768 recommended

HDD space for installation = 300MB

Connect the data stick included with your instrument to a USB port.
Navigate to the folder Ruskin Installation and double click on the file Ruski nSet up. exe.
Follow the installation wizard. By default, Ruskin will be installed to C. \ RBRRusKki n.

The logger uses a USB interface to communicate with Ruskin.
At the end of the installation, a prompt will appear asking, "Would you like to install the
logger driver at this time?"

Click Yes to install the drivers.

You may need to run the setup application as an administrator to install the driver
correctly.

A shortcut to Ruskin appears on the desktop and in a Start menu folder called RBRRuskin.

Please note that the most recent version of Ruskin can be found at https://rbr-global.com
/products/software

10
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5.2 Install Ruskin on a Mac

You can install Ruskin on a Mac running OS X 10.5 (Leopard) or later.

Steps

1. Insert the USB data stick in the appropriate USB port.
2. Navigate to the folder OSX and double click on the file Ruski n. dny.

3. When the disk image window opens, drag the Ruskin icon into the applications directory and
wait for the copy to complete.

4. To open Ruskin for the first time navigate to your applications directory, locate Ruskin, right
click on the icon, and select Open.

5. The dialogue box shown below will prompt you to authorize the opening of Ruskin.

“Ruskin” is from an unidentified developer.
9 g Are you sure you want to open it?

Opening “Ruskin® will always allow it to run on this
Mac.

Google Chrome downloaded this file today at 3:43 PM
from updates.rbr-global.com.

? Open | I

It may be required that you navigate to System Preferences > Security & privacy to
allow apps downloaded from “Anywhere” to complete the installation.

11
RBR#0000215revB



Ruskin User Guide

® Although you can specify a different folder for the working directory for the software, we
recommend that you use the default Applications folder.

A folder named RBRRuskin appears in the Applications folder.

You may want to drag the Ruskin.app application to the Dock.

5.3 Update Ruskin

To take advantage of new features and bug fixes, ensure that you are using the most recent
version of Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The
installation program deletes the older files before installing the newer ones. It does not delete any
Ruskin data files or log files.

The most recent version of Ruskin is always available on the RBR website (www.rbr-global.com).
However, if you already have an older version of Ruskin installed, Ruskin automatically notifies you
that a newer version is available when you start Ruskin. You can check to see if a new version is
available from within Ruskin navigating to the menu Help > Check for updates. If you have a
broadband connection, we recommend that you follow the installation instructions that appear on
your computer. Otherwise, request a USB stick from RBR.

If you do not have a broadband connection and/or are unable to install the Ruskin
updates, update notifications are available via email. To receive these notifications, send
an email to: support@rbr-global.com subject: "Ruskin update request".

5.4 Uninstall Ruskin

If you no longer need to manage RBR instruments from your computer, you can uninstall Ruskin.

Removing Ruskin will not delete your data files or your diagnostic logs.

12
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It is not necessary to uninstall an older version of Ruskin before installing a newer version. The
installation program deletes the older files before installing the newer ones. For more information,
see Update Ruskin (page 12).

Windows 7, 8, 8.1, or 10

Go to Start > Control Panel > Programs, and under Programs and Features, click Uninstall a
program. In the list, locate Ruskin — click Ruskin to highlight it, and then click Uninstall.

OS X 10.5 or later

Move the RBRRuskin folder from Applications to the Trash.

13
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6 Provide your feedback

You can get in touch with RBR in several different ways:

® Send us an email. For a technical question, write to support@rbr-global.com. For general
inquiries, use info@rbr-global.com.

® Send us a bug report from within Ruskin itself. Use the Help menu > Comment on Ruskin.
This allows you to include the diagnostic logs, and any other files (RSK datasets,
screenshots) that will help us reproduce the problem and help you as quickly as possible.

Steps
1. From the Help menu, click Comment on Ruskin.
The Feedback to RBR dialog box appears.

2. Enter your identification information, for example, email address and name, and then
summarize your comments.

3. Provide a detailed description and add any attachments, if required.

4. Click Submit to submit the report.

14
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7 Quick start

7.1 Deploy an instrument

Before you begin using your RBR loggers, you may want to experiment with the simulated loggers
that are included in Ruskin. For instructions on simulating a logger, see Simulating a logger (page
16).

When you are ready to use your own RBR loggers, we recommend that you follow the following
steps to ensure that you measure exactly what you want on the first attempt.
Steps

® |f you are using the logger for the first time, you can use either the default preferences or
specify your preferences to apply to all your loggers. For more information, see Preferences
(page 56). You can change these preferences at any time.

® Connect your logger locally through your computer's USB port. The logger should appear in
the Navigator view after a few seconds.

® Click the logger that you want to use. Ensure that it contains the sensors you expect to find
on the logger by viewing the Information tab in the Properties view on the right side of the
Ruskin window. For more information, see View information about a logger (page 16).

If you want to see live data sampled every few seconds but not saved, select the Fetching button
in the toolbar located above the Plot view. The Plot view is located at the bottom of the Ruskin
window.

© You must specify your preferences regarding these features before you enable the
schedule. For more information, see Configure a logger (page 18).

® |f you want to view or modify calibration coefficients, click the Calibration tab. For more
information, see Calibration tab (page 27).

® Click the Setup tab > Schedule tab to schedule the logger to take samples when and as
often as you want within the limits of your logger.

For more information, see Scheduling a logger (page 19).

15
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Ruskin prevents you from enabling a schedule that exceeds the memory capacity of the logger.
Ruskin also shows the estimated battery usage required to use your logger as scheduled. You
should seriously consider this information before you enable the schedule.

® |f you want to download data, click the Download tab to download all the data saved since
your schedule was enabled. For more information, see Download (page 25). The focus
changes to the new dataset in the Navigator view, and the static data appears in the Plot
view. You can now export the downloaded data to a file in Excel, Matlab, engineering text,
or raw text formats. You can also save the image as a PDF or PNG file for viewing outside
Ruskin.

7.2 Simulating an RBRsolo/duet

Ruskin can simulate most logger types that RBR produces, including the RBRsolo RBRduet. We
recommend that you experiment with your type of simulated logger before enabling a schedule for
your actual RBR logger. This practice will probably save you time in the long run, by ensuring you
are familiar with the options available.

Steps
1. From the Instruments menu, click Simulate instrument. The Configure Simulated
Instrument dialog box appears.
2. Under Logger type, select the Compact Instruments tab and select the appropriate options.
3. Click OK. The simulated logger appears under Instruments in the Navigator window.

4. Click the new simulated logger. You can work with this logger the same way as you work
with a real RBR logger, including: configuring, calibrating, logging, and downloading data..
Multiple loggers, both real and simulated, are listed in your Navigator window.

© If you want to remove a simulated logger, right-click it and click Remove simulated
instrument. You can also use the Instruments menu.

7.3 View information about a logger

You can view static information about a logger at any time as follows:

In the Navigator view, click the appropriate logger.

16
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The Setup tab in the Properties window on the right side of Ruskin identifies the logger, its logger
details such as model, serial number, generation, firmware version and battery status.

Logger details Schedule

Model: RBRsolo T

Generation: Late 2012 Logger clock

Serial: 907876

Firmware:  1.110 Start logging

Battery: [+ ] e 7

End logging

Use last setup

Logger status  Not enabled

2017-07-05 14:25:34 (UTC+0.00) UTC sync Local sync
2017-07-05 ~ | 2:23PM 2 Start immediately

Period (® Rate 2Hz <
2017-11-11 (~129.2 days, limited by battery) +| Fresh battery

Memory used: 0%

7.4 Recover an instrument and download data

When the deployment is complete recover your instrument and follow these steps to download

your data.

® Flooded loggers may be under pressure and opening a logger may be dangerous - take
precautions when opening a logger

Steps

® Start Ruskin

Carefully open the logger by unscrewing the pressure housing

Insert the micro USB connector into the logger (see Communicating with the logger (page

18)) and connect cable to your computer

The logger appears in the navigator window and select the Download tab and select

Download... (see Download (page 25))

Save the file to a preferred location

Evaluate your data (see Analysis (page 32))

17
RBR#0000215revB



Ruskin User Guide

8 Configure a logger

Before you enable a logger schedule, you can configure the logger to suit your requirements.

The instructions to configure a [tide or |wave logger are different than the standard loggers and can
be found in Waves and Tides. (page 21)

If your logger schedule is already enabled when you decide to change the configuration you must
stop running the schedule, make your changes, and enable the schedule again. However, any
data stored so far on the logger will be lost.

© You can preserve the data by downloading it to a file before you enable the schedule
again.

The Setup tab contains the Enable, and Use last setup buttons. When you click Enable, the
logger setup parameters are stored to the logger and the schedule is enabled.

Use last setup is intended for configuring multiple loggers using the same schedule. For example,
to set up three [tide loggers with exactly the same parameters, set one logger up and enable it;
connect the second and third logger and when you click Use last setup button, these two loggers
will be set up with the same parameters as the first logger. This includes the logger clock time,
start and end logging times, sampling period (or rate), gating condition, and tide or wave sampling
parameters for |tide or [wave loggers.

8.1 Communicating with the logger

To establish communication between the RBRsolo or RBRduet and a computer, open the
instrument (see Opening and closing the logger (page 63)) and remove the housing. There is a
micro-USB connector located on the back side of the logger. The supplied interface micro-USB
cable is plugged into this connector and the other end is attached to the USB port on your
computer.

18
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8.2 Scheduling a RBRsolo/duet

You can schedule your RBRsolo or RBRduet to start at a specified time and sampling rate. Ruskin
indicates any unattainable conditions in the defined schedule at the bottom of the Schedule tab,
and the Enable button is grayed out.

Steps
1. Connect your logger locally to computer's USB port. The logger should appear in the
Navigator view after a few seconds.

2. While the logger you want is highlighted in the Navigator view, click the Setup tab in the
Properties view.

=] RBRsolo 075992 &3
Setup Download | Calibration | Factory
Logger details Schedule
Model: RBRsalo T Logger status  Stopped, user request
Cenerationglarelz0 Logger clock 2016-05-05 17:48:16 UTC syne Local sync
Serial: 075892
Firmware: 1.110 Start logging 2016-05-05 ~ | 5:48PM @ Start immediately
Batiery: “ Sampling Period @ Rate  2Hz d
End logging  2099-12-31 Fresh battery
Enable logging Memory used: <1% Download...

3. Click either UTC sync to synchronize the logger with Coordinated Universal Time, or Local
sync to synchronize the logger with your local PC clock.

4. In the Start Logging boxes, specify the date and time that you want to start running the
schedule or select the Start immediately check box.

© If you select and then clear the Start immediately check box, you can then
manually modify the current date and time instead of the original values.

5. Specify the interval between samples using either the Period or Rate option. The Period
option allows you to set the sampling interval in units of seconds. The Rate option allows you
to select between 1 Hz or 2 Hz frequencies.

19
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All profiling loggers (known as |fast) have the ability to sample faster than 2Hz. For
example |fast16 loggers sample at rates of 2,4,8 or 16Hz. All [tide loggers can
average at rates of 2,4,8 or 16Hz. All |wave loggers can sample at rates of 2, 4,8 or
16Hz

6. An estimated end logging is shown at the bottom of the Setup tab based on the sampling
interval set. Check to ensure this date is beyond the end date of your planned deployment. If
you place your cursor over the end logging date, a message box will appear indicating
whether your deployment is battery or memory limited.

7. If the logger you are scheduling has had a fresh battery inserted, select the Fresh battery
box. Ruskin has the capability to calculate the remaining battery life available for a used
battery based on the number of samples that have been taken. The RBRsolo and RBRduet
keep track of the number of previously stored samples to determine the battery use.
Selecting and deselecting the Fresh Battery check box allows you to see the difference
between a fresh battery and a used battery.

0 If you select the Fresh battery box and enable the logger the previously stored
sample count is reset. In this case it is assumed that a fresh battery is installed.

8. To enable the logger to start sampling immediately or in the future click Enable logging. A
message appears informing you that the memaory will be erased.

9. Select Cancel if you need to download the previously sampled data or press Erase and
enable logging to enable the logger.

8.3 Stop logging

Logging stops on its own when one of the following occurs:
® The end logging time is reached.
® The power is removed.
® The logger memory is filled.
® The logger battery is depleted.

To manually stop the logger In the Properties view, click Setup tab and select Stop logging.

20
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Whether or not you make any changes to the schedule or the configuration, before
running the schedule again, a warning appears that the contents of memory will be
erased. If you want to save the data stored so far on the logger, you must download the
data to a file before proceeding. You can do this from Properties view > Setup tab and

select Download. For more information about downloading a file, see Download (page
25).

8.4 Waves and Tides solo and duet

8.4.1 Tides

This section applies to the RBRsolo D |tide and |wave and RBRduet T.D [tide and |[wave
loggers

[tide loggers use averaging to remove wave data from the pressure measurements. |wave loggers
can be set up to operate like |tide loggers.

From the Setup tab select the radio button "Tide" to enable the tide measuring regime.

Setup Calibration
Logger details Schedule
Model: RBRsolo D Logger status Stopped, user request
Sl Logger clock  2016-05-09 15:45:01 UTCsync | Local sync
Serial: 038036
Firmware:  1.000 Start logging 2016-05-09 ~  3:45PM 4 start immediately
Battery: L) Sampling regime Continuous OTide
Period ORate -z s
Sampling Tidal averaging duration  00:01:00 2
Tidal measurement period 00:15.00 2

End logging 2019-03-13 (~1037.4 days, limited by battery) Fresh battery

Enable logging Use last setup Memory used: <1% Download...

® In Sampling regime specify how fast you want pressure readings to be taken. Select
Period for 1s or slower and Rate for sub-second sampling rates.

® In Sampling specify the Tidal averaging duration (how long to average) and specify the
Tidal measurement period (the interval between averages).

21
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In the above example the averaging rate is set to 2Hz and the averaging duration is 1 minute and
this measurement is repeated every 15 minutes.

8.4.2 Waves

This section applies to the RBRsolo D |wave and RBRduet T.D |wave

A |wave logger records both wave and tide information, and the configuration is different from other
loggers. For additional information on planning a wave deployment, please refer to Appendix D -
|wave deployment planning.

© All |wave loggers automatically calculate tide data by averaging the wave burst data.
There is no setup required to determine tide information with the wave logger.

From the Setup tab select the radio button "Wave" to enable the wave measuring regime.

Setup Calibration
Logger details Schedule
Model: RBRduet T.D Logger status Mot enabled
Celeron g lael2nls Logger clock  2016-05-09 16:06:05 (UTC-4:00) UTCsync | Local sync
Serial: 991015
Firmware:  3.100 Start logging 2016-05-09 ~ | 4:06 PM Start immediately
Battery: @ Sampling regime Continuous Tide @ Wave Wave bandwidth estimates
Period @ Rate 4Hz & 1.0 Instrument altitude (m)
J ¥ depth of wat
Sampling Wave duration (samples) 2048 [~ ] 5.0 B e
. . Wave bandwidth: 0.0020 to 0.3413 Hz
Wave measurement period 00:15:00 Wave periods: 2.930 10 5125
End logging 2016-05-09 (~0.1 days, limited by memory) Fresh battery

® In Sampling regime, specify how fast you want pressure readings to be taken. Select
Period for 1s or slower and Rate for sub-second sampling rates.

® In Wave duration (samples), select the number of samples that you want to take during a
wave burst. The range is between 512 and 32768 samples.

® |n Wave measurement period, enter the interval between the bursts.

® |n Instrument altitude (m), enter the number of meters above the sea or river bed where
the logger will be secured in place. This value is used when making wave bandwidth
estimates.

22
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® In Mean depth of water (m), enter the total expected depth of the water where the logger
will be deployed. This value is used to estimate the range of wave frequencies and periods
that can be resolved. Ruskin calculates the actual depth from the measured pressure data
post-deployment.

8.5 Autoranging and fixed gain

Turbidity sensors are capable of autoranging. The logger can change the gain setting on the front-
end amplifiers in order to select the most appropriate range based on the environment being
measured. The logger can also set the gain on the sensor to a fixed value selected by the user,
rather than allowing the logger to select the gain as it measures.

From the setup tab under logger details there is a drop down menu where the Range of the sensor
can be specified. Seapoint turbidity sensors are capable of autoranging (automatic gain setting) or
having a fixed range of 2500, 500, 125 or 25 NTU.

Setup Calibration
Logger details Schedule
Model: RBRsolo Tu Logger status Mot enabled
Generation: Late 2014 Logger clock 2017-07-12 17:09:39 (UTC-4:00) UTC sync Local sync
Serial: 900060
Firmware: 3.010 Start logging 2017-07-12 ~ | 5:09PM I Start immediately
Battery: @ Sampling © Period 00:00:10
Range End logging  2080-01-23 (~15534 days, memory limited) Fresh battery
2500 NTU
500 NTU
125 NTU Memory used: 0%
25 NTU

Range change events are displayed in the Plot view when the Display diagnostic is selected

A

from the Events button, , located in the Plot view toolbar. Range change events are
displayed as RANGE XX Units where XX indicates the current range and units are the units of the
sensor — typically NTU for turbidity sensors and g/l for fluorometers. For |fast sampling where the
change may be occurring over a number of samples the event is displayed as RANGE CHG and is
followed by the final range event.

8.6 Deployment

Once you have ensured that the batteries are fresh, inspected the O-rings and programmed the
logger (see Configure a logger), the instrument is ready to be deployed.

23
RBR#0000215revB



Ruskin User Guide

There are four precautions you should take to avoid damaging the logger and maximise the
deployment autonomy:

1. Pay attention to the maximum pressure rating. All loggers with pressure sensors are
individually rated to a maximum depth/pressure. This is indicated by the label which is
placed on the logger's sensor end cap. Loggers which do not have a pressure sensor do not
have this label, but are limited by the maximum depth/pressure rating of either the logger
housing itself or of the sensors.

2. Avoid physical stress to the logger. Any type of clamp or bracket which concentrates the
stress to the logger body is not recommended for use in logger mooring, mounting, and/or
other deployment. Stress due to improper mounting may cause the logger to leak, resulting
in the loss of valuable data or permanent damage to the electronics. RBR can provide
proper mooring and mounting clamps suited to your specific application.

3. Use desiccant. If the logger is closed up in a warmer environment than the deployment
environment, internal condensation can result. Since condensation may cause the circuitry
to malfunction, the installation of desiccant prior to deployment is strongly advised.

4. Orientation on a mooring. Due to battery capacity potentially being sensitive to cell
orientation, it is best to mount the logger with the sensor end facing down when deployed.
Even if batteries that are minimally sensitive to cell orientation are used (e.g. Tadiran), it is
always good practice to mount the loggers in this manner in the event that any brand of
battery is employed.

24
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9 Download

9.1 Download data from the logger

You can download data from a logger at any time. If you stop running a schedule, you must
download the data before you restart the schedule to prevent the data stored so far from being
lost. It is not possible to start logging without erasing the memory contents.

Steps
1. Select the Setup tab and click Download.
The Save as RSK dialog box appears.

2. Specify a location and a name for the data file.
By default, the RSK file name uses the Ruskin file haming convention. For more information
about the naming convention, see File naming convention below.

3. The name of the new dataset appears and is highlighted automatically in Navigator view >
Datasets.
The Properties view changes to the new dataset and contains the following tabs: Analysis,
Overview, Channels, and File Info. All the data that was stored on the logger at the time of
the download is automatically plotted in the Plot view.

Downloading data again while the same schedule continues to run, picks up the same
data plus any data stored since the last download.

You can add a comment after downloading a dataset.

9.2 File naming convention

In Ruskin, by default, the name of a data file is composed of the following information:
® The first six digits represent the logger serial number.
® The next eight digits represent the current year, month, and day.

® The next four digits represent the current time to the minute.

25
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® The file extension indicates the file format and should not be changed. If you change it, the
file extension that you specify becomes part of the name, and the required extension is
appended.

For example, the file named 911936_20090522_1613.rsk contains data for a logger with a serial
number of 911936 whose data was downloaded in 2009 on May 22 at 4:13 pm.

26
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10 Calibration tab

The Calibration tab displays the calibration coefficients for each channel (sensor) present and the
date and time of the last calibration.

Setup |Calibration

Time Parameter ca

c1 cz c3
2017-07-06 10:32:26 3.5000000E-03| -250.00000E-06| 2.7000000E-06] 23.000000E-09] |

Store calibration Revert calibration Check calibration expiry Request calibration quote

You can request a calibration quote for your logger by selecting Request calibration quote and
sending the information directly to RBR Ltd. In the Calibration tab, click Request calibration
guote, and when the Request calibration dialog box appears, enter the appropriate information.
Make sure to verify that all information is correct before sending the request. You can edit any of
the coefficients and use Store calibration to save the new coefficients to the logger. Use Revert
calibration to recover to the original coefficients is you have not already selected Store
calibration.

Calibration coefficients are calculated for each sensor, and the coefficients are stored in the logger.
Calibration certificates are provided for each sensor and contain the both the calibration equation
and the coefficients. Hard copies are provided with each shipment, and the documents are
contained inside the shipping box. Please refer to the calibration certificates for the coefficients and
residuals. RBR can replace lost or misplaced calibration certificates.
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11 Update firmware

Instrument firmware upgrades can be performed from within Ruskin on a Windows-based
computer without having to return the instrument to the factory. Ruskin automatically checks to see
if a newer version of firmware is available and displays a message in the Information tab

£l RBRsolo 075529 &

Setup - Calibration

Legger details Schedule
Model: RBERsolo T Logger status | Mot enabled
Generation: Late 2012 | o poer clock 22/5ep/2014  13:00:51 UTC sync | Local sync
Serial: 075529 ) = _ _
Firmware:  1.100 Start logging | 7/ 92014 [E~ || 232PM = [ ] Start immediately
Battery: @ Sampling (U Period @ Rate |2Hz

End logging  089/Dec/2014 (Estimated) [ | Fresh battery
Enable logging Usze last setup | Memory used: 0% Download...

Update firmware

Click the Update firmware button to upgrade the logger firmware. The following screen will
appear:
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Use this utility to update your logger.

Release notes:

Version 1.110, 16-May-2013
Mew Feature release for RBRsoloT
Requires Ruskin 1.8.0.

Improvements

+ More robust response to and recovery from power loss (LL-650).
+ Various bug fixes (LL-655, LL-603, LL-761)
+ MNew platform compatibility (LL-595)

® Do not disconnect the logger until the process is fully completed. Disconnecting the
logger during this process may render the logger inoperable.

If for some reason RBR needs to supply a version of firmware version the following method is used
to manually update the logger firmware.

0]
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Contact RBR for instructions before proceeding. This method of updating the firmware
should only be attempted with the assistance of RBR.

Click the Instruments menu > Update logger firmware.

Lisae this ultility to update your Ioogger.

Specify thie lncation of thie RER suppled update image Fle

Sedect file. ..

Redairse nokes:

Spedify the port o which vour looger is connecked
HI w

Co=)

® Do not use the HID port to upgrade your logger firmware. Use the COM port instead.

Steps
1. In the Instruments menu, click Update logger firmware.
The Update logger firmware dialog box will appear.

2. Click Select file and browse to the location of the firmware update file provided by RBR.
The file will have the extension .rbrfw.
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. Use the drop down list to select the COM port of the logger.

If you have multiple instruments connected and do not know the correct COM port to use, in
the Navigator view click L Instruments. The Connections view appears and you can see
the port being used in the Port column of the table. To close the Connections view, select
the X.

. Click Proceed to start the firmware upgrade.
A progress bar shows the status of the upgrade. Once the firmware upgrade is complete, the
message Update completed successfully appears at the top of the dialog box.

. If the upgrade doesn't complete successfully, click Proceed again to retry until successful.

Occasionally the upgrade will succeed but the logger disappears from the
Navigator view. If this occurs, disconnect your logger from the USB port and then
reconnect to re-establish communication.

. Click Close.
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12 Datasets

12.1 Open a stored dataset

You can open any stored dataset to explore its contents.

Steps

1. Click File menu > Open dataset.
2. Double-click the .rsk file that contains the data that you want to view.

3. The name of the dataset appears and is highlighted automatically in the Navigator view.
The Properties view changes to the dataset. The data in the file is automatically plotted in
the Plot view.

© To close a dataset, right-click its name in the Navigator view and click Close dataset. Or
use File > Close dataset

o Ruskin performs an integrity check that is intended to make sure that older data
files are compatible with newer versions of Ruskin software. This information is
displayed in File info (page 38). If the file requires updating the message indicates
the issue with the file, and how long an update will take.

RBR strongly recommends that all files that have issues be updated.

12.2 Analysis tab

The Analysis tab contains information and settings for configuring the calibration information and
to display statistical information. You must already have an open dataset to view and configure
these settings. For information about how to open a dataset, see Download (page 25).
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12.2.1 Cursor tab

When a file is selected and plotted the analysis tab can be selected to display information about
the dataset channels and their values.

C1074520_20161027_1455P.rsk E3

Analysis Overview | Channels | File info

Sample 5285
Tirme 2016-10-27 11:42:07.000 (UTC+0.00)

Display statistics

Mumber of samples

Channel Value Unit
Temperature 219032993 “C
Pressure 55.1626636  dbar
Sea pressure 45.0301636 dbar
Depth 44.6629588 m

This table reports the value at each sample number when selected in the plot referenced to the
vertical black cursor.

The sample number and time of the sample are displayed.

Selecting Display statistics gives you the ability to determine the average value and standard
deviation over a range of samples. Change the number of samples in the average by using the
spin buttons. The grey bar that appears on the plot view is the range of the samples in the
average.
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Analysis

Sample
Time

Overview | Channels | File info

Display statistics

-~

Mumber of samples 30 -
Channel Value
Temperature 21.8032993
Pressure 55.1626636
Sea pressure 45.0301636
Depth 44 6629588

2016-10-27 11:41:37.000 - 2016-10-27 11:

Avg
219032974
57.9591548
47 8266548
47.4366456

5255 - 5285
42:07.000 (UTC+0.00)

Std
0.0001577
2.0948127
2.0948127
2.0777302

Uit
°C
dbar
dbar

12.2.2 Calibration tab

When a file is selected and plotted for re-calibration the calibration tab can be selected to assist
with calculation calibration coefficients, see User calibration (page 49) .

12.3 Overview

When a file is selected and plotted the overview tab can be selected to display general information

about the dataset.
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Analysis | Overview Channels | File info

File name: jUsers/jtaylor/Desktop/074520_20161027_1455P.rsk

Dataset Logger Schedule
# of samples: 16899 hModel: RERduet Gate none
# of events: 2 Serial: 74520 Starttime: | 2016-10-27 10:14:03 (UTC+0.00)
# of diagnostics: 0 Firmware: 2.010 End time: | 2016-10-27 17:12:55 (UTC+0.00)
# of errors: 0 Period: 00:00:01

Comment

This is also the form on which you can enter a comment for the dataset and then press Save
comment to save it.

12.4 Channels

The Channels tab display three additional tabs: Information, Calibration, and Parameters.

The Information tab displays the measured parameter, the sensor manufacturer and the range
setting. The type of derived channels and how it is calculated is displayed in a separate table.

The Calibration tab displays the calibration coefficients for each sensor.

The Parameters tab displays the values of the parameters, default values if other required
parameters are required and the method used to calculate the derived channels.

12.4.1 Information tab

The Information tab displays the measured parameters, the sensor manufacturer and the range
setting (if applicable). It also shows any derived channels that are available, and a description of
the methodology used in the calculation of that derived parameter.
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Analysis | Overview Channels File info

Calibration Parameters

Measured channels

# Parameter Sensor Range
1 Temperature (°C) RBR None
2 Pressure (dbar) RBR MNone

Derived channels

# Parameter Motes
3 Sea pressure (dbar) Removes atmospheric pressure
4 Depth (m) Seawater derivation

12.4.2 Calibration Tab

The Calibration Tab displays the calibration coefficients and temperature correction coefficients (as
applicable) for each channel (sensor) and the date and time of the last calibration.

Analysis | Overview | Channels File info

Information w Parameters

Time Parameter ca c1 cz C3
2016 Oct 26 12:08:23 Temperature 3.4634530E-03 -252.84080E-06 4 2.4384370E-06 -86.558024E-09
2016 Oct 27 15:07:39 Pressure 9.6950392E+00 90.428560E+00 -734.B7665E-03 3.2094721E+00

Use deployment calibrations
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Analysis | Overview Channels File info

Information | Calibration | Parameters

Time Parameter (] c1 cz2 C3
2016 Oct 26 12:08B:23 Temperature 3.4634530E-03 -252.B4080E-06 2.43B4370E-06 -B6.558024E-09

Pressure | 9.6950392E+00] 95.000000E+00| -734.87665E-03| 3.2094721E+00] |

Store and recompute data Rewvert calibration Use deployment calibrations

You can edit any of the coefficients and use "Store and recompute data" to recalculate the dataset.
Use "Revert calibration” to recover to the original coefficients is you have not already selected
"Store and recompute data". To recover the original calibration coefficients edit one of the values
and click in another cell the "Use deployment calibrations" check box becomes active and
unchecked, check the checkbox to restore the coefficients used by the logger and then press
"Store and recompute data" to save the coefficients.

12.4.3 Parameters tab

When a file is selected and plotted, the Parameters tab can be selected to display the parameters
used to calculate any applicable derived channels.

The tab reports the relevant derived channel information for the sensors on the logger. The
parameters can be edited to change the derived channel calculation. Once a parameter is
modified, the Update and recompute and Revert settings buttons become active.

Revert settings rereads the RSK file and populates the form with the parameters from the file.
Update and recompute writes the new parameters to RSK file and re-displays newly calculated
data.

The following example is for a CTD and dissolved oxygen logger where you can change the
calculation parameters to calculate the derived channels:
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Analysis | Overview | Channels File info

Information Calibration

O simplified depth derivation
Seawater derivation

Atmospheric pressure (dbar)  10.132501

Density (g/em?) 1.0260206
Latitude (degrees) 0.0
Speed of sound type UNESCO u

Selecting the Seawater derivation in the Parameters tab results in a depth calculation based on
UNESCO Technical paper 44.

The depth derivation equations can be found under the menu item Options menu > Preferences
> Derived Channels > Depth tab.

For |wave loggers you can change the wave calculation by adjusting how the depth is calculated
and by adjusting the instrument altitude.

12.5 File info tab

When a file is selected and plotted the File info tab can be selected to display information about
the file.

Analysis | Overview | Channels | File info

File name: [Usersfjtaylor/Desktop/RBR_Desktop/Data/cast data/060163_20140715_1516.rsk
Version: 1.8.9

Structure: full

Size: 78.266 MB

A new version of the RSK file format is available.

The anticipated update duration is 04:22

Update
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o

Files created by older versions of Ruskin must be updated to ensure compatibility. Failing
to do so may result in odd graphical display and incorrect reporting of the sample values.

If the message A new version of the RSK file format is available. appears, click Update. The
update process may take some, however, Ruskin does estimate the time with the message The
anticipated update duration is <time period>.

12.6 Plot view

You can use the Plot view to view a graphical display of data in datasets or live data. When
viewing live data, the logger must still be attached.

A toolbar at the top of the Plot view contains various buttons to help you customise, explore, and
export the graphical display.

Each channel appears as a different colour in the graphical display. These colours are specified for
all graphical displays in Options menu > Preferences > Plotting and can be changed only there.
You can also change other defaults affecting the Plot view in Preferences. For information, see
Specifying plotting preferences (page 59)

Scaling of the data is based on the on the minimum and maximum value sampled for
each channel - sometimes there are erroneously high or low values that may make the

real data appear incorrect. Use the vertical zoom 2 2 {0 increase the scale of the data
displayed.

You can click a particular time (location) in the plot to view each channel value and related
statistics at that time. A vertical black line marks the place. The Cursor tab panel above displays
the channel values, units, the sample number, and the time that the data was measured.

For datasets only, you can select the Display statistics check box to view the average value and
standard deviation for each channel based on the number of samples that you specify.

If you want to copy the data to the clipboard and then paste it into another application, select a
row, a column, a cell or click on the word channel for the entire table and then click Copy.

The graphical display for each dataset appears on its own tab in the Plot view. The dataset file
name appears at the top of the tab. The icons differentiate at a glance the live data from the
datasets.

A
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If a graphical display does not appear, click the Line style button and ensure that either
Draw lines or Draw markers is selected.

12.6.1 Thumbnail view

Large data sets can take a long time to display on older systems, and to facilitate data viewing,
large files may be down sampled and displayed in a thumbnail view. This view is presented below
the main Plot view and contains a sliding window. The data within the window is displayed in the
Plot view. This window may be repositioned by using the next and previous keyboard arrow keys,
or dragging it using the mouse, or double-clicking to position the window in the appropriate location
in the thumbnail view. The sliding window reports the date and time at the center of the window
when selected and moving. The Plot view for large files is limited to displaying about 20,000

samples.
1 066015_20170109_0449.rsk 52 Profiles (4) <] 24 e IR A e @ Qe B#E oo RO
&
— — 7 =
l)é 7|

12.6.2 Live data

You can use the Plot view to view a graphical display of samples being fetched at the default
speed for your logger type.

The graphical display for live data for each logger appears on its own tab in the Plot view. The
logger model and serial number appear at the top of the tab. The icons differentiate at a glance the
live data from the datasets.

© If a graphical display does not appear, click the Start live plot or Resume live plot
button. If the graphical display still does not appear, click the Line style button and
ensure that either Draw lines or Draw markers is selected.

12.6.3 Plot Tools

Live data toolbar

40
RBR#0000215revB



Ruskin User Guide

RO E- B A X X
Dataset toolbar
PN A- @@ aen G- EHoR B

Zoom tools for datasets and live data

Purpose

Compress or
expand data
horizontally

Compress or
expand data
vertically

Return to the
original view

Return to the
original range

Button

Horizontal
zoom in

4] Edl'

Horizontal
zoom out

q.Ed..

Vertical
zoom in
Vertical
zoom out

a

Reset
zoom

o

Auto
ranging

el

How to use

Click the appropriate button to zoom in or out.

The expansion or contraction is centered on the vertical black
line in the plot. If no line exists, the focus is in the center.

Click the appropriate button to zoom in or out.

The expansion or contraction is centered on the vertical black
line in the plot. If no line exists, the focus is in the center.

Click the button to return to the original view of the graphical
display.

Click the button to return to the original range of the graphical
display
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Other tools for datasets and live data

Purpose

Show or
hide a
legend in
the plot

Save an
image of
the
graphical
display to
a file

Show
lines or
markers
for each
channel

Show
lines or
markers
for each
channel

Show
events,
diagnostic
events

Button

Show
legend
/Hide
legend

-

Export
plot
3

Line
style

Show
/hide
channels

i| v
E

How to use

Click this button to toggle between showing and hiding a legend at the
bottom of the plot.

Click the button and then specify a file type (PDF or PNG), location, and
name for the file that will contain an image of the graphical display
currently in the Plot view.

If you want the legend to be included, first click the show legend button.

Click the button and then click Draw lines, Draw markers, or both. If
you click neither, no graphical display appears in the Plot view.

Click the button and select which channels to show in the Plot view. You
can choose to show or hide specific channels used by your logger, or all
the channels of a particular type, such as measured, derived, depth, or
temperature.

Tip: If you want to view the uncalibrated data for measured channels in
the form of a voltage ratio instead of as engineering units, select Toggle
raw channels.

Click the button and select Display dataset events, Display diagnostic
events or Display dataset errors. A green icon indicates no errors, and
a red icon indicates error events exist and a yellow icon indicates that
diagnostic events exist. Refer to Appendix C - Event and Error Stamps
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Purpose

and errors
in the
graphical
display

Show or
hide data
panel
(streaming
and
fetching -
live data)

Minimize
the Plot
view

Maximize
the Plot
view

Button

Display
any
dataset
events
or errors

&"'

L.
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How to use

(page 72) for a description of the events and errors. Dataset events
appear on the x-axis as a vertical grey line with a stamp to indicate the
type of event, such as STP for a stop event in a dataset.

Click to hide the tab called Main that is referred to as the Data panel.
This tab shows how many samples the logger has collected, the time
and date, and a table that helps to easily view the information collected.
If you select a row in the table, you can copy that row using the Copy
row button. The row is saved to the clipboard where you can then paste
the row into a text editor or word processing program.

If you want to copy just one cell, click the cell you want to copy, and click
the Copy cell button.

Note: The Copy row button changes to Copy cell when you select a cell
in the table.

Click the button to place the Plot view as an unopened view in the
margin of the Ruskin window.

Tip: To restore the Plot view to its former size, click the restore button in
the margin.

Click the button to expand the Plot view to the full size of the Ruskin
window.

Tip: To restore the Plot view to its former size, click the Restore button
in any margin that contains an unopened view.
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Tools only for datasets

Purpose

Select a
channel to

place on the

y-axis

Show or
hide
thumbnail

Toggle
depth plot

Show or
hide axes

Select
rendering
options

Move to the
next
annotation

Button

Set
domain
axis

E -

Showr/hide
thumbnail

& i

Depth Plot
=

Show/hide
axes

2

Rendering
options
il v

Next
Annotation

L g

Previous
Annotation
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How to use

Click the button to reorganize the graphical display so that the
selected channel from the drop down menu becomes the vertical, or
y-axis, and all other channels are plotted along the horizontal, or x-
axis.

Tip: Click the maximize button to more easily view the graphical
display.

Click the button to toggle between showing and hiding the thumbnail
view

Toggle between time domain and depth domain

Click the button to toggle between showing and hiding the vertical
axes to the left of the plot.

Click on the button and select Dots, Lines, Markers, or Lines and
Markers.

Click to move plot view to the next annotation

Click to move plot view to the previous annotation
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Purpose

Move to the
previous
annotation

Move to the
last
annotation

Move to the
first
annotation

Button

€

Last
Annotation

=

First
Annotation

=

Tools for live data

Purpose

Toggle
between
fetching
samples at the
default speed
and viewing
streamed data

Start, stop, or
restart the flow
of data in the
Plot view

Button

Live plot mode

Fetching =
Resume live
plot

[
Suspend live
plot _
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How to use

Click to move plot view to the last annotation

Click to move plot view to the first annotation

How to use

The logger supports either streaming or fetching data.
Fetching is the action of asking the logger to take a reading
and report it. Ruskin displays the fetched data every 1-2
seconds. Fetching is disabled if the logger is enabled. In
streaming mode, Ruskin receives streamed data from the
logger at the sampling rate set during the logger
configuration.

Click the button to start, stop, or restart the flow of data in the
Plot view. If you click the Suspend live plot button, the
graphical display is frozen. If you click the Resume live plot
button, the flow of current data resumes.

In the Plot view, data is not recorded during the time that the
live plot is suspended. However, data continues to be stored
on the logger as scheduled.
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Purpose

View chart
display by time
or all data

Show or hide
axes

Delete the data
in the Plot view

Save the data
in the live plot

12.6.4 Keyboard Shortcuts

Button

View all data

View all data

Show/hide
axes

X

Clear plot

el

Save live plot

K
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How to use

Click the button to display a drop down list of time span
options to display the data by time period. For example,
display 2 minutes of data. You can also choose to display all
of the data collected.

Click the button to toggle between showing and hiding the
vertical axes to the left of the plot.

Click the button if you want to delete all the data in the Plot
view for all channels.
Note: Any data stored on the logger is preserved.

Click the button to save the data in the plot.

To navigate in the plot a number of keyboard shortcuts are available.

® Move to the next sample: Arrow Right (Next arrow)

® Move to the previous sample: Arrow Left (Previous arrow)

® Double click to zoom in to the range of the annotation

® Zoom a region: Press and hold shift key and then click the left mouse button and drag the
window that appears.

¢ Pan: Press and hold the Ctrl key and then and then click the left mouse button and drag the
mouse left or right or up or down across the plot.

® Shift arrow moves by a minimum of 10 samples or 10% of the current displayed data

To navigate in the thumbnail view

® Anywhere you click you will centre the master overlay
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® You can click and drag from the centre of the master to pan

® If you click on the edge of the master overlay the cursor will change and you can resize the
window

¢ Scroll to zoom the master overlay

® Your data cursor will show up in the thumbnail view, but it can only be updated from the
main plot

12.7 Exporting datasets

You may want to share your data with others or analyse your data using other software. You can
export data as a text file, which can then be imported into many applications, or export it in a
particular format for analysis in Microsoft Excel, Matlab MAT or OceanDataView.

The Raw, Engineering and Pressure burst file format depends on the logger type and sensors in
use.

The Raw format contains decimal voltage ratios which un-calibrated readings. The Engineering
format contains the data in the units of the sensor; these are calibrated sensor readings. The
Pressure burst is the file of pressure burst readings and is only applicable to |wave loggers. The
Engineering file contains all the data presented in the Plot view and in the case of |wave loggers
the wave analysis data as well. In a |wave Engineering file there are two parts to this file — the plot
view data and the wave analysis.

You must already have downloaded the data to a dataset or opened an existing dataset.
Steps

1. Right-click the dataset whose data you want to export, and hover to Export as to open a
submenu, or use File menu > Export dataset.
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4 Navigator = O || = 095738_20170509_1557P.rsk 52
L |Instruments
M| MLM

¥ Ds Datasets

a
B 095738_201 7Py

Analysis ~._Overview Channels | File info

1 Sample
03 Excel
= Text ‘
| % OceanDataView spreadsheet Display statistics
(] Excel xLs
<\ Matlab MAT | —
™ Pressure| 2 Engineering
Sea pressure Pressure burst (raw)
Depth Pressure burst {(engineering)
TWR wave
TWR tide

2. Select the appropriate export format (Excel, Text, OceanDataView or one of our Legacy
formats). Under the Legacy formats you will find exports for Excel, Matlab, and Rtext files (
Raw, Engineering or Pressure burst).

TWR file formats apply to the older loggers and are not available for Logger2.

® Exports to Matlab may fail if the RSK file size exceeds 20MB. Alternatively, an RSK
file can be imported directly into Matlab with our toolkit RSKtools that is available
for download from our website at www.rbr-global.com. The RSK file is a single file
database based on SQLite that allows us to have very large files with high-speed
access to any part of the dataset.

Large files may not export completely into any of these formats. Large files should
be converted to .txt and processed after the fact. The Excel export is limited to
65000 rows

3. Specify a location and a name for the data file.

4. Click Save.
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13 User calibration

Change calibration coefficients

Sensors such as the dissolved oxygen sensor that can be field calibrated will require you to update
the calibration coefficients for these channels periodically. You may also need on occasion to
manually enter new coefficients, although this is not recommended for factory calibrated sensors
(for example T or D) unless instructed by RBR.

Steps

You can view static information about an instrument at any time as follows:

1. In the Navigator view, under the Instruments list, click the appropriate logger.
2. Click Analysis tab > Calibration tab to show the current calibration coefficients.

3. To manually change a coefficient, click on the appropriate entry in the table (C1, C2, C3,
etc.). The current entry will be highlighted, and the new value can be typed.

4. If a two point calibration has been performed, and calculated coefficients have been copied,
right click on either the Time or Parameter entry for the parameter you wish to modify.
Select Paste to selected row from the drop-down menu.

5. Click Store calibration to write the calibration coefficients to the logger.

6. If you need to revert to previous coefficients, click Revert calibration.

If you do not click Store calibration, the coefficients will not be written to the instrument,
and will be lost once your session is closed.

13.1 N-Point calibration

Sensors such as Dissolved Oxygen (Oxyguard (page 50)) or turbidity (page 52) generate a
voltage output that is proportional to the value of the parameter being measured. To calibrate
these sensors, Ruskin offers an N-point calibration method to generate calibration coefficients.
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13.2 Oxyguard DO calibration

The Oxyguard DO sensor has a true zero point and therefore it can be calibrated using
the single-point calibration method using a reading at 100% oxygen concentration only.
The 100% calibration should be performed at the expected temperature and salinity of the
deployment environment.

If the logger has a pH/ORP sensor and Oxyguard DO sensor, it is advisable to ensure
that the pH/ORP and Reference sensors are submerged in the water during
measurement.

Equipment

1. Two Large mouth beakers

2. Sodium sulphite Na,SO4

3. Aguarium air pump

4. Magnetic stirrer
Preparing solutions

Reference Point 1 solution — Oxygen saturated solution at expected temperature and salinity of
deployment environment.

1. Fill the large beaker with 2 L of water. And install magnetic stirrer.
2. Bubble air through the water using an air pump (an aquarium air pump would work).

3. Switch ON the air-pump and the magnetic stirrer.
Reference Point 2 solution — Dissolved oxygen concentration of zero

1. In a beaker, dissolve approximately 5 tsp of sodium sulfite (Na2S0O3) into 500 mL tap water.

2. Mix the solution thoroughly with a magnetic mixer. The solution will be oxygen-free after 15
minutes.

Steps

1. In Ruskin, configure the instrument to sample at a fast rate, between 6 Hz and 3 seconds.
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. Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the

end time is set so that the logger will keep sampling until calibration is complete.

Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15
minutes near the stirrer so that it is in the best mixed area of the bath.

Take sample readings for at least 15 minutes for the 100% calibration point, making note of
the time that the sample is being measured.

Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15
minutes for the 0% calibration point, making note of the time that the sample is being
measured.

Retrieve the data from the data logger as per the steps in Download (page 25).

. The calibration data should now be displayed in the Plot view. In the Properties view, go to

Analysis tab > Calibration tab.
Select the dissolved oxygen sensor type from the drop-down list.

The Number of Samples spinner box is automatically set to 100.
This value is the number of sample points Ruskin will average the calibration coefficients for
the sensor. Typically, this value should be in the range of 50 to 100 samples.

Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the
first row, under Real Avg, enter 100 and press enter.

Select the check box in the second row in the table, then click on a stable point in the Plot
view corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0
and press enter.

Ruskin automatically calculates the calibration coefficients, and these values appear in
Calculated coefficients. Clicking the Copy button saves the new calibration coefficients to
the clipboard.

Follow the steps in Change calibration coefficients (page 27) to update the coefficients for
this sensor in the data logger.
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13.3 Turbidity calibration

The Seapoint turbidity sensor is calibrated with a two-point calibration technique. The calibration
should be performed under fluorescent lighting.

Equipment (entire logger submerged)

® 4000-FTU Formazin standard — 500 ml
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Distilled water — 5 L

Black-walled, wide-mouth container (large enough to hold the logger)
Volumetric flask 1000 ml, class A

Volumetric flask 200 ml, class A

Stir stick

If you plan to submerse only the sensor, you can decide on the container volume and
adjust the solution volumes appropriately.

Steps (preparing solutions)

1.

In Ruskin, configure the data logger to sample using a 10 second sampling interval and set
the sensor to autoranging - see Autoranging and fixed gain (page 23).

Use Sync to PC to ensure the logger clock is synchronised to the PC clock, and ensure the
end time is set so that the logger will keep sampling until calibration is complete.

. Flush the sensor, container and glassware with distilled water and dry them.

. Fill the black wall container with 5000 ml distilled water using the large volumetric flask.

Set the sensor in the container until the sensor is fully submerged in the distilled water.

The distance from the sensor's windows to the container wall must be at least 20
cm. If possible, place a dark cover on the calibration container and avoid direct light
on the container.

. Record the data in distilled water for five minutes.

This is the zero-turbidity calibration point.

Fill the 500 ml volumetric flask with Formazin Standard. Remember to gently shake the
bottle before opening the Formazin solution.

Add 500 ml Formazin Standard to the black wall container with distilled water, and gently mix
the solution with a stirring stick.

. Calculate the value of the standard turbidity solution at calibration point according to

following formula:

©
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Calculating dilution

Tugtp = TUst*™Vror/VpwtVror) = 363.63 FTU

Where:

Tugyp = turbidity of the standard solution (FTU)

Tugpk = 4000FTU — turbidity of the stock solution

V1ot = 500 ml volume of stock solution at calibration point (ml)
Vpw = 5000 ml - initial volume of distilled water

After five minutes, remove the logger from the calibration container and wash the sensor
head under regular tap water.

Retrieve the data from the data logger as per the steps in Download (page 25).

The calibration data should now be displayed in the Plot view. In the Properties view, go to
Analysis tab > Calibration tab.

Select the Tu sensor type from the drop-down list.

The Number of Samples field is automatically set to 100.
This value is the number of sample points Ruskin will average calculate the calibration
coefficients for the sensor. Typically, this value should be in the range of 50 to 100 samples.

Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row,
under Real Avg, enter 0 and press enter.

Select the check box in the second row in the table, then click on a stable point in the Plot
view corresponding to reading of your turbidity solution. In the table in the second row, under
Real Avg, enter the value of your turbidity solution and press enter.

Ruskin automatically calculates the calibration coefficients, and the values appear in
Calculated coefficients. Clicking the Copy button saves the new calibration coefficients to
the clipboard.

Follow the steps in Change calibration coefficients (page 49) to update the coefficients for
this sensor in the data logger.

By using the above formula and changing the volume of distilled water and Formazin
solution, you can prepare different calibration points or different volumes for checking
linearity of the turbidity sensor or getting close to real turbidity value of standard turbidity
solution.
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14 Preferences

Ruskin sets global preferences that require no changes in many situations. However, as you learn
more about what Ruskin can do, you may want to change some of these defaults to better suit
your requirements. The global preferences include:

® where to store output files

® plotting preferences

¢ configuring derived channels

® calculating derived channels when sensors are missing

You can change these preferences at any time.

14.1 Specify location for log files

You can control where log files are stored by default. Specify these locations before downloading
any data.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.

3. In File location, type a directory name in the Directory for log files text box, or click
Browse to locate the directory where you want to store log files.

Log files are used when you request RBR support.

4. Click Apply or OK.

You can change where future log files are stored by default at any time. The change takes effect
immediately.

14.2 Specify Language selection

Steps
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1. From the Options menu, click Preferences.

N

. In the list on the left side, click General.

w

. In Language selection, select a language from the list.

N

. Click Apply or OK.

14.3 Using advanced sampling controls

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.

3. In Sampling control, select Enable advanced sampling controls check box to change
from the simple control.

4. Click Apply or OK.

Simple control: provides a default list of fixed values

Advanced control: provides the user the ability to enter any values.

14.4 Derived channels - RBRsolo-RBRduet

Ruskin calculates all the possible derived channels for that specific logger.

The RBRsolo D and the RBRduet T.D measure pressure and from that sea pressure and depth is
derived. The RBRsolo DO measures percent dissolved oxygen saturation and from that dissolved
oxygen concentration may be derived.

14.4.1 Depth channel

To set up the initial values to derive depth and sea pressure select the menu item Options, then
select Preferences, then select Derived channels and select the Depth tab. Enable the depth
channel and select the appropriate calculation methods and edit the default parameters.
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Derived Channels

Enable and configure derived channels

m Conductivity - Salinity  Dissolved 02 Mo sensor values

Enable Depth Channel
Any logger with a pressure channel
Atmospheric Pressure (dbar) | 10.1325
o Simplified derivation: depth[m]=(pres-atmos)[dbar]/(density*0.980665)
Density (g/mL) | 1.0281
Seawater derivation: UNESCO Tech Paper in Marine Science NMo. 44

Latitude (degrees) |0.0

Enter the average expected Atmospheric pressure and the expected density of the water (default
values are populated). There are two methods to calculate depth - select the appropriate method
using the radio buttons. Sea Pressure is calculated by subtracting the Atmospheric pressure.

For downloaded files, use the dataset Parameters tab to edit the parameters to derive the

channel.

14.4.2 Dissolved Oxygen concentration

To set up the initial values to derive dissolved oxygen concentration select the menu item Options,
then select Preferences, then select Derived channels and select the Dissolved 02 tab. Enable
the Dissolved Oxygen channel and select the desired concentration units (uMol/L, mg/L or mL/L)

from the drop down list.

Derived Channels

Enable and configure derived channels

Depth  Conductivity - Salinity | Dissolved 02 [y bEIEN, values

Enable Dissolved Oxygen Channel

Any logger using an Oxyguard DO sensor

Derive concentration using the Weiss equation

Use the following unit = mL/L d
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For downloaded files, use the dataset Parameters tab to edit the parameters to derive the
channel.

14.5 Specifying plotting preferences

You can specify how you want the graphical display in the Plot view to behave by default. With the
exception of choosing colours for each channel, these preferences can be overridden for a
particular graphical display in the Plot view.

© You can click Apply to save your changes without closing the dialog box.

14.5.1 Channel visibility tab

The Channel visibility tab displays many options to hide or show specific information in the Plot
view. These settings are applied when displaying a dataset in the Plot view. Some information in
this tab is enabled by default. When you select any of the check boxes in this tab, the action is
immediate.

Channel visibility tab with default settings
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Plotting

Manage default plotting behavior

annel visibility Channel colours

By default, hide any measured channel underlying a simple derived channel
Show dataset events by default

Show dataset errors by default
Automatically save live data to a file
By default, hide all measured channels

Hide temperature channels Hide conductivity channels
Hide pressure channels Hide distance channels
Hide dissolved O2 channels Hide fluorometery channels
Hide pH channels Hide PAR channels

Hide ORP channels Hide BPR channels

Hide transmittance channels Hide turbidity channels

Hide voltage channels

By default, hide all derived channels

Hide salinity channels Hide depth channels

Hide distance channels Hide specific conductivity channels
Hide density anomaly channels Hide pressure channels

Hide speed of sound channels Hide dissolved 02 channels

Steps

1. From the Options menu, click Preferences.

2. In the list on the left side, click Plotting.

3. On the Channel visibility tab, select the check box for the information you want hidden.
Events appear at the x-axis as a vertical grey line with brief text to indicate the type of event,
such as STP for a stop event in a dataset. Refer to Appendix C - Event and Error Stamps

(page 72) for a list of the event types.

4. To hide all measured channels, select By default, hide all measured channels check box.

5. To hide all derived channels, select By default, hide all derived channels check box.

6. To show information, clear the check box beside the information you want shown.
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14.5.2 Channel colours tab

The Channel colours tab allows you to choose a different colour for each channel that is shown
for information currently running in Plot view, or from an opened dataset. If there is no colour
available that you like, you can create your own colour. When you select a colour, the new colour
is immediately updated by Ruskin.

Channel colours tab with the Colour dialog box to customize a colour for a channel

Plotting

Manage default plotting behavior

Channel visibility

CHAMNMEL_1 &

CHANNEL_2 —_ 4

CHANMNEL_3 u
CHANMNEL_4
CHAMNMEL_S
CHANMEL_G
CHAMMNEL_7
CHANMNEL_B
CHAMNMEL_9

Colors

i @
(e
%

I

CHAMMEL_13
CHANMNEL_14
CHANMEL_15
CHAMMEL_16

Channel colours can be previewed on the active plot, I

Steps

1. From the Options menu, click Preferences.

2. In the list on the left side, click Plotting.

61
RBR#0000215revB



o g M~ W

Ruskin User Guide

Click the Channel colours tab.
In the channels listed, click the channel you want to change the colour for.
Click the colour box that appears beside the channel list.
With the colour dialog box open, select a colour from the Basic colour area.
Select OK to apply the colour to the channel.
To create a custom colour:

a. Repeat steps 4 and 5.

b. Click Define Custom Colours and then choose a colour.

c. Click Add to Custom Colours to add the new colour to Custom colours.

o

. Click OK to apply the new custom colour to the channel.
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15 Logger Hardware

15.1 Opening and closing the logger solo duet

To open an RBRsolo or RBRduet logger, unscrew the sensor end counter-clockwise while holding
on to the yellow housing. Once fully unscrewed, the housing can be carefully slid away from the

sensor endcap, revealing the sensor carriage.
The sensor carriage contains the battery compartment, desiccant holder and USB port (Figs. 1 and

2).

RDRRsolo

[R AA3.6VLisOCl, 0! -
e

Closing the logger is exactly the reverse of opening it. Remember to keep the O-rings clean and
avoid scratching the O-ring mating surfaces. Carefully inspect the O-rings, before deploying the
logger. Do not use excessive force when tightening the end sensor end; hand-tight is quite
sufficient, as the seal depends upon the O-rings, not the end cap tightness.
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15.2 Changing the batteries solo duet

RBRsolo and RBRduet data loggers are powered by one (1) AA size 3.6V lithium thionyl chloride
cell.

The logger will not operate with alkaline or zinc-chloride 1.5V AA batteries, you must use
3.6V lithium thionyl chloride cells. The instrument will not operate with rechargeable
batteries.

RBR recommends using Tadiran brand batteries only (part# TL-4903) in your logger.
Generally, lithium thionyl chloride cells sensitive to orientation, and if the logger is placed
with the positive end facing downward (logger sensor pointing up), it will suffer from
decreased capacity and reduced battery life. Tadiran cells are minimally sensitive to this
orientation effect.

To remove the battery, use either your finger or a blunt tool to push the battery from its holder
using the keyhole opening (Fig. 3) on the back of the carriage.

Fig. 3 Opening for battery removal

To insert the battery, press the battery into the battery holder, ensuring it is correctly oriented with the
negative terminal placed towards the electronics (Fig. 4 and 5). The label in the logger indicates proper
battery placement.
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AA 3.6V LiSOCI,
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Fig. 4 Battery orientation label

Fig. 5 Battery holder with battery

15.3 Installing desiccant solo duet

The RBRsolo has a dedicated location for placement of desiccant in the sensor carriage, which will
accommodate one (1) Dricap desiccant capsule (part # 02-01207AG35).

To remove the desiccant, use your finger or a pen to push through the small hole in the carriage
and eject the desiccant.
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Insert a fresh desiccant capsule into the desiccant holder, ensuring that it is secure.
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16 LED behaviour

Your RBRsolo or RBRduet has a red LED located next to the USB connector. The LED will flash in
various patterns depending on the state of the instrument, as follows:

Action LED Response
Connect download cable Lights for one second

Disconnect download cable from programmed logger  Blinks slowly for 6 seconds - 2 times per
(either logging or pending) second

Click Enable button and confirm memory erase Blinks rapidly for 5 seconds two times -
5 times per second

@ Newer models

RBRsolo and RBRduet manufactured from late 2014 onward have the LED disabled. The
generation of your logger can be seen in the Setup tab under logger details.
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17 Maintenance and repairs

17.1 Instrument calibration

We recommend that you verify the calibration of your data logger before any critical deployment,
periodically once a year, or if you suspect the calibration to be out of specifications. Discuss your
calibration needs with RBR. In some cases, you will be recommended to return the instrument to
RBR to have it checked and re-calibrated. Please contact us for our current calibration fees.

17.2 O-rings solo duet

The single most important item of maintenance on any RBR submersible data logger is care of the
O-rings. Any kind of water leak can damage the circuitry beyond repair and cause complete data
loss. Every logger's seal depends upon its O-rings, not the end cap tightness. Proper O-ring
maintenance, therefore, is crucial. The RBRsolo and RBRduet use two O-rings. One is the main O-
ring and the other is the backup O-ring. Both O-rings are required to ensure that the logger does
not become flooded. The correct placement and orientation of the two O-rings is critical to
maintaining depth rating integrity.

The backup O-ring is flat on one side, and cupped on the other. When installing, the grooved side
must be located towards the main O-ring.

Badiup Caing MMain O-ring

\

Badiup Oning MMain Oring
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Before you remove the O-rings from the RBRsolo or RBRduet, make yourself familiar with their
orientation and location. Inspect the new O-rings provided in the loggers support kit — there are two
types. The back-up O-ring is a flat O-ring with a concave channel on one side. The main O-ring is
round.

Baclup  Mam
O-nng  O-ring

i é O-rmg
.‘_

Groove Thermistor end

Battery end

Inspecting O-rings

Give particular attention to the following areas:
® The surface of the O-ring itself
® The mating surface on the inside of the case between the threads and the open end
® The inner surfaces of the groove in the end cap where the O-ring sits

Any dirt present should be removed by wiping thoroughly with a soft, lint-free cloth. When cleaning,
never use any material or tool which could scratch the O-ring or any of its mating surfaces. If any
dirt is present in the O-ring groove, then the O-ring should be removed as described below to allow
thorough cleaning of the groove. If an O-ring needs to be removed for any reason, it should be
replaced.

If the O-ring is scratched, cut, distorted, perished or defective in any other way it must be replaced.
If any of the surfaces of the O-ring groove are scratched, pitted or otherwise damaged, the logger
may need to be returned to RBR for refurbishment: please contact us for advice support@rbr-
global.com.

Replacing an O-ring

1. Lever the O-ring from its groove. Use a soft plastic or wood tool; do not use a metal
screwdriver or any other tool which may scratch the surfaces of the O-ring groove: doing so
will probably render the end cap useless. Slide the O-ring out of its groove and off the
logger. The O-ring may need to stretch quite a bit as it is pushed off; this requires some
effort but can be done by hand.
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2. Thoroughly clean the O-ring groove, taking great care not to scratch or damage it in any
way. Inspect it carefully, and contact us for advice if it appears damaged. Apply a light film of
silicone grease to all three inside surfaces of the groove, being careful not to trap any dirt,
hairs or lint.

3. Select the proper O-ring and make sure it is not damaged. Lubricate it with a very light film of
silicone grease to ease its installation. The correct order and orientation is as follows
(assuming the o-rings have been removed): Install the main O-ring first by sliding it over the
electronics housing (it is too small to fit over the sensor cap). Install the back up o-ring
making sure that the concave part faces toward the sensor end and will mate with the main
o-ring. The flat part of the backup o-ring must mate flat with the O-ring backing wall. Make
sure there are no twists in either O-ring.

4. When the new O-ring is in place, inspect it once more for scratches and dirt, and wipe away
any silicone grease deposited on the end cap.

Many experienced users of oceanographic equipment replace all O-rings before every deployment
as a matter of routine. The cost of an O-ring is negligible compared with the cost of the instrument
and its deployment. Routine replacement of O-rings, therefore, is cheap insurance.

17.3 Repairs

We support all instruments and software that we manufacture. First line support is always available
by phone, fax or e-mail. Please contact us immediately if you are experiencing problems with your
RBR product. It is very important to contact us before returning your instrument, as some
difficulties can be easily solved on-site by the user. Please have the model and serial number of
the unit handy when you contact us at support@rbr-global.com.

There are no user-repairable parts of the logger. Any attempt at repair, whether successful or not,
without prior authorization from RBR Ltd. will void the warranty. If it is necessary to return the
product to RBR for an upgrade, repair, or calibration; please review the detailed shipping
information on our website www.rbr-global.com before returning the unit.

In the unlikely event of an instrument requiring service at RBR, contact us for an RMA number and
please use the following shipping address:

RBR Ltd

95 Hines Road Unit 5
Kanata, Ontario
CANADA K2K 2M5
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Telephone +1 (613) 599-8900

For those who are shipping from outside of Canada, you will need to clearly mark the waybill and
any other customs paperwork with the following:

"Canadian goods being returned to manufacturer for repair. NOT A SALE."

Please state the instrument value on the waybill as closely as possible to the current market value
based on the original purchase price less depreciation. Please contact RBR if you have any
guestions about the instrument value. Send the unit using your own preferred method (prepaid).
However, we suggest that you do not use Ground Service, since customs brokerage charges will
be billed incorrectly.

Units repaired under warranty will be returned prepaid by RBR. Warranty repairs are decided on a
case by case basis.

Standard Repair Charges (Non-warranty)

Our minimum repair charge is $150 CAD. This charge covers a comprehensive initial check,
including verification calibration and sensor functionality. Minor repairs are also covered by this
basic fee. If further repair work or re-calibration is necessary, a quotation will be issued to the
customer. Once we have received authorization to proceed, the repair shall be completed and the
instrument returned as soon as possible.Please note that any units returned with low (or no)
batteries will have new batteries installed, and the costs will be added to the repair invoice.

17.4 Support kits

To simplify maintenance of your data logger, RBR sells support kits with enough O-rings, and
silicone grease for 5 deployments. Please contact RBR for more information or to place an order.
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18 Appendices

18.1 When to replace the batteries

Compared to the cost of deployment, the cost of a new set of batteries is close to negligible. We
highly recommend that the batteries be replaced before every deployment unless there is no doubt
that they have sufficient capacity.

Battery voltage does not decrease linearly and is therefore not an accurate indicator of battery
capacity. However, if the logger software indicates a yellow or red battery icon on the setup
screen, the batteries should be replaced.

® When in doubt, replace the batteries

18.2 Appendix B - O-ring specifications

Each logger has two user replaceable O-rings located near the sensor end above the thread. We
strongly recommend that the O-rings be replaced regularly: before every deployment, after
changing batteries, or at least once a year.

RBRsolo and RBRduet: #2-115 N70 O-ring, 8-115 N90 backup ring

18.3 Appendix C - Event and Error Stamps

The following is a list of event/error stamps that may be displayed in the data set.

TIMESTAMP - Time synchronization event, is used to ensure timing synchronization, whenever
there is a possibility that the actual date/time of a sample according to the logger's internal calendar
Iclock does not match what is expected in the normal sampling sequence.

USER STOP - Sampling stopped by user, is used to indicate that a command to stop sampling
occurred.

UNKNOWN - An unknown error has occurred, is used to indicate that the error has occurred in the
logger and the cause of the error is unknown.
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ERROR ## - Change event (system restart where logger clock is no longer valid), is used to

indicate an internal error has occurred in the logger.

RESTART ## - Warm startup event (clock and programmed parameters are valid/unharmed),
indicates a system restart, in which all programmed parameters are valid.

GAIN### - gain change event

Below is a description of all the different event stamp types ## which could be encountered. Some
of these are quite common, while others indicate very rare fault conditions. Some may also occur
together in various combinations, with no sample data between them.

Error## code

00 eDATA_ERROR_CATCH_ALL
01 eDATA_ERROR_EOC

02 eDATA_ERROR_DMY

03 eDATA_ERROR_MODULE_ADDR
04 eDATA_ERROR_OVERFLOW

05 eDATA_ERROR_BUS_BUSY

06 eDATA_ERROR_TX_FAIL

07 eDATA_ERROR_RX_TIMEOUT
08 eDATA_ERROR_PARSING

09 eDATA_ERROR_NO_SAMPLE

10 eDATA_ERROR_IN_PROGRESS
11 eDATA_ERROR_FAILED
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generic/unknown/unexpected error

A/D *EOC bit was set (should always = 0)

A/D *DMY bit was set (should always = 0)

invalid address used for RBR channel

too much data to send to front end

access to internal bus denied

timeout sending command

timeout receiving response

generic failure to interpret response

no sample was started

sample acquisition still in progress

sample process failed somewhere
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12 eDATA ERROR_AVERAGE average computation error (no valid
samples)
13 eDATA_ERROR_REPLY_SHORT front end reply contains fewer characters

than expected

15 eDATA_ERROR_UNABLETOCOMPUTE unable to compute derived/cross channel

18.4 Appendix D - [wave deployment planning

he following provides a guideline to establish a coherent deployment for |wave loggers.

The |wave logger should be fixed to a suitable support below the surface of the water, such as a
dock or other rigid mooring. The logger must not be able to move in the water. The figure below
offers a view of the logger fixed to a dock with a definition of the different water heights.

* Mean depth of water: an estimate of the average water depth, used for the initial prediction
of expected wave frequencies that can be detected. Ruskin will use the actual depth
measured by the logger for its calculations.

® Instrument altitude: The actual height of the logger above the seabed. This is defined by the
deployment, and the logger must be physically affixed at this height during the installation.

Given the height of the logger above seabed and the depth of logger as measured during the
deployment, the total depth of water can be calculated.
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Figure 1. Logger positioning

18.4.1 |wave logger positioning

For deployment planning, refer to Figure 1. Ruskin needs to know the expected mean depth of
water (in metres) and the expected altitude (height) of the logger above the seabed to provide an
estimate of the frequencies and periods of the wave that the logger is be able to measure. The
logger measures water depth/pressure by means of a pressure transducer. The physics of what a
pressure transducer can 'see' at depth depends on the height of water above the transducer as
well as the amount of water below the transducer. High frequencies attenuate very quickly with
depth. Figure 2 shows the attenuation with depth as a function of wave period in seconds ( period
= 1/frequency). This graph demonstrates that the placement of the logger is critical in determining
frequencies/periods of the wave data to be captured by the logger. The pressure transducer may
be placed in any orientation.

The basic rule is to place the logger as close to the surface of the water without the
possibility that the logger will emerge from the water either because of large waves or low
tides.
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Figure 2. Wave attenuation as a function of depth for various wave periods.

This step in the deployment configuration requires that the 'expected mean depth of water', that is
the total depth of water known from experience with the measurement site, and the 'expected
altitude of the logger above seabed', a definition to be given to the diver, be entered. Note that on
data retrieval the second value will be added to the measured depth of water above the logger
when performing all wave calculations.

When waves are enabled, the logger takes multiple pressure readings in a burst which allows for
the reconstruction of the surface wave time series. There are three parameters which define the
wave data:

Measurement speed : this defines the sampling rate or period for individual pressure readings
used.

Wave calculations. The rate possibilities are 1Hz and 2Hz, and for newer models (mid 2014 and
later) 4Hz, 8Hz, and 16Hz.

The sampling rate defines several elements of the data capture:
1. The highest possible frequency visible in the data is limited to ¥z the sampling frequency.

However, this mathematical limit can not usually be achieved because of the attenuation
characteristics shown above.
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2. The sampling frequency defines the resolution of the frequency spectrum which can be
calculated from the wave data;

3. The sampling frequency, together with the burst length, define the lowest frequency which
can be assessed in a wave burst.

Wave measurement period: this defines how often wave bursts are collected.

Burst Length: this defines the number of samples in a wave burst. It must be a power of 2 and is
chosen from the list: 512, 1024, 2048, 4096, 8192, 16384, and 32768. The longest wave period to
be assessed is defined by: burst length/sampling frequency

The wave parameters work together to define the range of wave information which can be
calculated as well as the memory and battery usage.
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